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Foreword 

This course was written for trainees wishing to learn to use Microsoft Excel. It is written for using Microsoft 
Excel in the Office 2007 suite of applications. A ‘New Features’ section is included and it is very easy to see a 
complete list of the new features in Office 2007 in the Help menu on-screen. This courseware cannot and should 
not compete with the comprehensive coverage of new features detailed by Microsoft within the application’s help 
files. To do so would be to hinder learning the raw application. 

What this course seeks to do is teach the trainee Excel in the hope that he/she may be able to go and work just as 
well using Excel 2002 for example and other versions. Wherever possible, ‘version functionality’ is purposely 
avoided.  
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MODULE 1: EXCEL ESSENTIALS 
OBJECTIVES: 

At the completion of this session you will be able to:  

• Start Excel 

• Use Selection Techniques 

• Enter Data 

• Finish a Workbook 

 

TOPICS 

Starting Excel ..................................................................................................... 3 

What is a Worksheet? ....................................................................................... 4 

What is a Workbook? ........................................................................................ 7 

Identifying Parts of the Screen ......................................................................... 8 

The Ribbon ...................................................................................................... 10 

Using Selection Techniques ............................................................................ 10 

Selecting a Range of Cells ............................................................................... 13 

Selecting Nonadjacent Cells and Ranges ........................................................ 15 

Selecting an Entire Worksheet ........................................................................ 16 

Entering Data .................................................................................................. 16 

Entering Text Data into a Cell ......................................................................... 17 

Entering Values ............................................................................................... 21 

Entering Data into a Range ............................................................................. 23 

Quickly Adjusting a Column Width ................................................................. 25 
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Finishing a Workbook ..................................................................................... 26 

Saving a Named Workbook ............................................................................. 29 

Printing a Worksheet ...................................................................................... 31 

Closing a Workbook and Exiting from Excel ................................................... 32 

Assignment ...................................................................................................... 34 

  

 



STARTING EXCEL 

This course assumes that your work or training environment uses a computer 
system running Microsoft Windows. There are many versions of Windows but 
they all look similar. It is the most common computer desktop interface. 
However, many work-related workstations and systems operate with a 
combination of windows (for general applications, such as Excel) and 
bespoke or specific company systems and applications. Consequently, you 
may need to switch from a bespoke environment to Windows. Your instructor 
or IT / IS Manager will advise you on this. 

 

To work with Excel effectively, you need to know several basic skills and 
concepts; how to start Excel from the Windows desktop, how to make the 
most of the Excel interface, how worksheets are used, and how to select cells 
and ranges. 

 

STARTING  EXCEL 

Once you are in Windows, starting Excel is a matter of a few clicks.  

METHOD  

To load Excel: 

 

1.  On the taskbar, click the Start button. 

2.  From the Start Menu, point to Programs. 

3.  From the Programs menu, choose Microsoft Excel. 
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EXERCISE
 

In this exercise, you will load Excel. 

 

 1. (If necessary)  Switch to 
Windows or start Windows 

 

 2. On the taskbar, click the Start 
button 

The Start menu opens. 

 3. Point to Programs The Programs menu opens. 

 4. Choose Microsoft Excel.  
NOTE: Excel may be in a sub-
folder named Microsoft Office) 

Excel starts, showing the main 
screen with a blank worksheet. 

 

WHAT IS A WORKSHEET? 

A worksheet is the electronic equivalent of a paper ledger. It is a powerful 
platform used to enter, analyze, calculate, and manipulate data. A worksheet 
can be used for basic calculations such as addition and subtraction, as well 
as more complicated applications like statistics, audits, or mortgage tables. 
Moreover, worksheets allow you to quickly format your data into effective 
business reports. 

 

A worksheet is a grid of 1, 048, 576 rows and 16, 384 columns. The rows are 
labeled with numbers (1, 2, 3, ...) and the columns are labeled with letters (A, 
B, C, ..., AA, AB, AC,…), as illustrated in Figure 1-1. The intersection of a row 
and column is a cell, the basic unit for storing data. The highlighted column 
and row headings indicate the active cell. You’ll find the active cell’s cell 
reference in the Name box. The cell reference consists of the highlighted 
column letter and row number, in this case D9. A range is a rectangular group 
of cells; the range reference is derived from the cell references of top left cell 
and the bottom right cell separated by a colon. 
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Please note that the illustration below is not how the section of the 
worksheet would be seen in Microsoft Excel version 2007. An image of the 
actual view of the same section is shown below. The greyscale version is 
shown for clarity of purpose only. 

 Column heading 

Row 
heading 

Name box 

 
 

Figure 1‐1: Rows, Columns, Cells, and Ranges.  

 

Figure 1‐2: Selected cells and ranges are shaded soft blue.  
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Above – the section of worksheet as actually seen in Microsoft Excel version 
2007. Note that the selected areas are shaded a soft blue. This is so that the 
user can clearly see the contents of selected cells and ranges and even 
formatting. See example below for an enhanced view of selected – formatted 
- cells. 
 

 

 

 

Figure 1‐3: The shading of selected cells and ranges allows formatting to show through. 
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WHAT IS A WORKBOOK? 

A workbook is a collection of worksheets stored in the same file. These 
worksheets may contain different types of information, but they are usually 
related in some fashion. For example, each worksheet of a sales workbook 
may contain sales data for a specific division. 

 

Workbooks can contain an unlimited number of worksheets, depending on 
worksheet size and the amount of memory your computer has. Besides 
worksheets, a workbook can include chart sheets, Visual Basic modules, 
dialog box sheets, macro modules, and scenario report sheets. 



IDENTIFYING PARTS OF THE SCREEN 

The Excel window is illustrated in Figure 1-2. The bulk of the screen is 
occupied by the worksheet window. This grid provides a convenient 
workspace where you can enter and manage your data. Surrounding the 
worksheet window are several command interfaces, each of which allows you 
to receive information about, or apply functions to, the data on the worksheet. 
Table 1-1 describes the various parts of the Excel window.  

 

 

 

Figure 1‐4: The Excel Window 

 

 

 

Figure 1‐5: The Quick Access Toolbar 
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Screen Part Function 

Worksheet control 
buttons 

The worksheet control buttons allow you to minimize, 
maximize/restore, or close the worksheet. 

Formula bar The formula bar allows you to enter and edit data in the 
worksheet. 

Worksheet window The worksheet window contains the open, active 
worksheet. Worksheet windows can be moved and sized. 
You can have more than one worksheet window open at 
the same time. 

Scroll bars The vertical and horizontal scroll bars enable you to move 
quickly through the worksheet, vertically and horizontally. 

Ribbon The Ribbon is designed to help you quickly find the 
commands that you need to complete a task. Commands 
are organized in logical groups, which are collected 
together under tabs. Each tab relates to a type of activity, 
such as writing or laying out a page. To reduce clutter, 
some tabs are shown only when needed. 

Title bar (extreme top 
right of the Excel 
window) 

The title bar contains the name of the application and the 
active file. 

Office Button Clicking on the Office Button displays a drop down menu 
containing a number of options, such as open, save, and 
print.  
The options in the Office Button menu are very similar to 
options found under the File menu in previous versions of 
Excel. 

Sheet tabs (Worksheet 
tabs) 

The sheet tabs let you switch between worksheets in a 
workbook by clicking the appropriate tab. 

Quick Access Toolbar The Quick Access Toolbar (see Figure 1-3) is a 
customizable toolbar that contains a set of commands that 
are independent of the tab that is currently displayed. You 
can move the Quick Access Toolbar from one of the two 
possible locations, and you can add buttons that represent 
commands to the Quick Access Toolbar. 

 

Table 1‐1: The Parts of the Excel Window 



THE RIBBON 

The Ribbon is the strip of buttons and icons, organised into TABS, located 
above the work area in Excel 2007.  

 

The Ribbon (with its various tabs) replaces the menus and toolbars found in 
earlier versions of Excel.  

 

At the top of the actual Ribbon are a number of tabs, such as Home, Insert, 
and Page Layout. Clicking on a tab displays the options located in this section 
of the ribbon. 

  

For example, when Excel 2007 opens, the options under the Home tab are 
displayed (see image to the right). These options are grouped according to 
their function - such as Clipboard (includes cut, copy, and paste options), and 
Font (includes current font, font size, bold, italic, and underline options).  

 

Clicking on an option on the ribbon may lead to further options contained in a 
Contextual Menu that relate specifically to the option chosen. 

 

 

 

 

Figure 1‐6: The Clipboard and Font Sections of the Excel 2007 ‘Home Ribbon’ 

 

Although, as written in the label for Figure 1-4, tab sections can be referred to 
as [tab name] ribbon, like Home Ribbon, Insert Ribbon, etc, tab sections can 
also be referred to as only their tab names. Eg. the Home tab, the Insert tab, 
the Page Layout tab, etc. 

USING SELECTION TECHNIQUES 
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Before you can enter data, you have to select a cell. Before you can change 
the data, you have to select it. In this section, you’ll learn effective, easy 
techniques that enable you to select cells, ranges, and nonadjacent cells. 
With one click, you can even select your entire worksheet, which is definitely 
a timesaver when it comes to making global changes. 

 

SELECTING A CELL 

Selecting a cell is the first step in entering data or executing most commands 
in a worksheet. The single cell that receives the data or formula you enter is 
the active cell. When a cell is selected, its border becomes bold and the 
column and row indicators are highlighted. 

METHOD  

To select a cell: 

1.  Click the desired cell. 

or 

1.  Use the arrow keys to move to the desired cell. 
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EXERCISE

 

In the following exercise, you will select cells using the keyboard and the 
mouse. 

 1. If cell A1 is not selected, click it 
using the mouse. 

Cell A1 is selected and is the 
active cell. 

 2. Press DOWN ARROW 4 times A5 becomes the active cell. 

 3. Press RIGHT ARROW 2 times C5 becomes the active cell. 

 4. Click cell E5 E5 becomes the active cell. 
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SELECTING A RANGE OF CELLS 

A rectangular selection of multiple cells is referred to as a range. You may 
wish to select a range when entering a group of data or when you wish to 
perform the same action on several cells. The range appears as a shaded 
block of cells, and the active cell in a range is defined by a bold border and 
white background. When a range is selected, its column and row headings 
are highlighted. In Figure 1-5, the selected range is referred to as B6:C9 
(“B6 to C9”). 

 

 

Active 
cell 

Selected 
range 

 

 

Figure 1‐7: A Range of Cells 

METHOD  

To select a range of cells: 

 

Mouse method 

1.  Select the first cell of the desired range. 

2.  Drag the mouse pointer through the range of cells you wish to 
include. 
or 

2.  Press and hold SHIFT, and then click the final cell of the range. 

3.  Release SHIFT. 

 

Keyboard method 
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1.  Use the arrow keys to move the cell pointer to the first cell of the 
desired range. 

2.  Press and hold SHIFT, and then use the arrow keys to highlight the 
desired range. 

3.  Release SHIFT. 

EXERCISE

 

In the following exercise, you will select ranges of cells using the mouse and 
the keyboard. 

 

 1. Select cell A1  

 2. Drag the mouse pointer to 
cell D5 

The range A1 to D5 is selected 

 3. Using the arrow keys, 
select cell B2 

Cell B2 is selected. The first range, 
A5 to D5, is deselected. 

 4. Press and hold SHIFT, and 
then use the arrow keys to 
select cell E7 

The range B2:E7 is selected. 

 5. Release SHIFT  

 6. Select cell A1 The range B2:E7 is deselected. 

 7. Press and hold SHIFT, and 
then click cell D1 

 

 8. Release SHIFT The range A1:D1 is selected. 

 9. Click cell A1 The range A1:D1 is deselected. 
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SELECTING NONADJACENT CELLS AND RANGES 

As a rule, to select multiple, nonadjacent objects in Windows, you employ the 
CTRL key. For example, you may use CTRL and the mouse to select multiple 
files or folders in Explorer or My Computer. This method also works in Excel 
to select nonadjacent cells and ranges. 

METHOD  

To select nonadjacent cells or ranges: 

 

1.  Select the first cell or range. 

2.  Press and hold CTRL 

3.  Select the next cell or range. 

4.  Release CTRL 

 

EXERCISE

 

In the following exercise, you will select nonadjacent cells and ranges. 

 

 1. Make sure cell A1 is 
selected 

 

 2. Press and hold CTRL  

 3. Select cell C4 Cells A1 and C4 are selected. 

 4. Using the mouse, select 
the range B6:E10 

Cells A1 and C4, and the range 
B6:E10 are selected. 

 5. Release CTRL  

 6. Select cell A1  
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SELECTING AN ENTIRE WORKSHEET 

Selecting an entire worksheet is useful when you want to make changes on a 
global scale. For instance, you might want to change the size of the font in 
every cell in the worksheet. Once you select the entire worksheet using the 
Select All button, illustrated in Figure 1-6, you can do this in a single step. 

Select All button 

 

Figure 1‐8: The Select All Button 

METHOD  

To select an entire worksheet: 

1. Click the Select All button. 

 

EXERCISE

 

In the following exercise, you will select the entire worksheet. 

 

 1. Click the Select All button The entire worksheet is highlighted. 

 2. Click any cell Only the clicked cell is selected. 

 

 

 

 

ENTERING DATA 
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The first step in creating a useful worksheet is entering data. By entering 
data, you are inputting the information that you want Excel to display, 
calculate, and store. Data can be entered into a cell or a range of cells. You 
can even set up a sequence of data and let Excel fill in the remainder of the 
sequence based on your first few entries. 

 

IDENTIFYING TYPES OF DATA 

Excel worksheets contain four types of data: text, values, dates, and 
formulas. Examples of each are found in Table 1-2. 

 

 

Text Value Date Formula 

Supplies 852.34 12/3/02 =C3+D3+E3 

12 Dozen 42980.00254 Jan 3, 2001 =245*C3 

 

Table 1‐2: Examples of Data Types 

 

 

Text data is alphanumeric and cannot be used in most formulas. Values are 
numerals only. Although a date may seem to be text, as soon as you enter 
what Excel recognizes as a date, it is formatted and stored using a decimal 
date format. As a result, dates can be used in complex functions. 

 

Formulas are made up of values and operators. Because formulas contain 
references to worksheet cells and ranges, they depend on other elements of 
the worksheet. For instance, if a formula includes a reference to cell C3 and 
you change the value that is located in C3, the result of the formula will 
change accordingly.  

ENTERING TEXT DATA INTO A CELL 

A single cell can hold up to 32,000 alphanumeric characters. If the cell is not 
wide enough and if the cell to the right contains data, some characters may 
not be visible. Excel hasn’t lost this data; it just doesn’t show it. 



 

On occasion, you may need to enter a number as text. For example, you may 
want to exclude a number from a summed column. If you type an 
apostrophe (’) before the number, for example ‘2007, Excel accepts it as 
text and aligns it on the left, as illustrated in Figure 1-7. All other numbers are 
right-aligned by default. The apostrophe does not show up in the worksheet 
cell, but you can see it in the Formula bar. You don’t need to type the 
apostrophe when a phrase begins with a number as long as it includes text 
characters⎯for example, 1st Quarter Summary. 

 

 

   

 

Figure 1‐9: Value Entered as Text 

 

 

When you enter functional data into your worksheet (that is a calculation or 
part thereof; e.g. the equals sign), three buttons appear in the Formula bar to 
the right of the Name box, shown in Figure 1-8. Use the Cancel button if you 
decide not to continue to enter the data into the cell and the Enter button to 
accept the entry. The Edit Formula button is only operable when the cell 
contains a formula.  

 

 

 
 

 

Cancel 
Enter 

Edit Formula Name box 

 

Figure 1‐10: The Formula Bar 
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METHOD  

To enter text data into a cell: 

 

1.  Select the cell. 

2.  Type the information in the cell. 

3.  Click the Enter button. 
or 

3.  Press ENTER to enter the data and move down one cell. 

or 

3.  Select another cell. 

 

To cancel data before it is entered: 

 

1.  Click the Cancel button. 
or 

1.  Press ESC 

 

 

 

 

EXERCISE

 

In the following exercise, you will enter text data into cells. 

 

 1. Select cell A1  

 2. Type Brian’s Orchard  
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 3. Click the Enter button Brian’s Orchard appears in 
A1, and appears to flow into 
the next column. A1 is still the 
active cell. 

 4. Select cell A2  

 5. Type 1st Quarter Summary  

 6. Click cell A3 1st Quarter Summary 
appears in cell A2 and cell A3 
is the active cell. 

 7. Type 2007  

 8. Click the Cancel button The entry is canceled. 

 9. Type ’2007  

10. Press ENTER 2007 appears in cell A3 as text 
and A4 is the active cell. 

11. Using the worksheet shown in 
Figure 1-9 as a guide, enter 
the headings for cells A5, B5, 
C5, D5, and E5. 
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ENTERING VALUES 

You enter values into the worksheet the same way you enter text. However, 
it’s important to note that values can contain only the following characters: 

 

1  2  3  4  5  6  7  8  9  0  +  ‐  (  )  ,  /  $  %  .  E  e 

METHOD  

To enter values in a cell: 

 

1.  Select the cell. 

2.  Type the value in the cell. 

3.  Click the Enter button. 
or 

3.  Press ENTER to enter the value and move down one cell. 
or 

3.  Select another cell. 

EXERCISE

 

In the following exercise, you will enter values into cells. 

 

 1. Select cell C6  

 2. Type 65  

 3. Click the Enter button 65 appears in cell C6. 

 4. Select cell C7  

 5. Type 35  

 6. Select cell C8 35 appears in cell C7. 
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 7. Type 20  

 8. Press ENTER 20 appears in cell C8 

 9. In cell D6, enter 0.59   

10. In cell D7, enter 1.12   

11. In cell D8, enter -0.25   

 



ENTERING DATA INTO A RANGE 

When you enter data into several adjacent cells, you can save time and 
reduce keystrokes by first selecting the range of cells you want to work with. 
Pressing the ENTER key after typing the data places the data into the cell and 
automatically selects the next cell in the range. 

METHOD  

To enter data into a range: 

 

1.  Select the desired range. 

2.  Type the information into the first cell. 

3.  Press ENTER to move to the next cell. 

4.  Type the appropriate information. 

5.  Repeat steps 3 and 4 until all information is entered. 

EXERCISE

 

In the following exercise, you will enter data into a range. 

 

 1. Select the range B6:B10 The range is selected, and B6 
is the active cell. 

 2. Type Apple Butter  

 3. Press ENTER B7 is the active cell 

 4. Type Peach Jam  

 5. Press ENTER B8 is the active cell 

 6. Type Free Sample  
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 7. Press ENTER B9 is the active cell 

 8. Type Pear Butter  

 9. Press ENTER B10 is the active cell 

 10. Type Roger’s Peanuts  

 11. Press ENTER B6 is the active cell 

 12. Select the range C9:D10 The range C9:D10 is selected. 
The active cell is C9. 

 13. In cell C9, type 44, and then 
press ENTER 

Cell C10 becomes active. 

 14. In cell C10, enter 114, and 
then press ENTER 

Cell D9 becomes active. 

 15. In cell D9, enter 0.69, and then 
press ENTER 

Cell D10 becomes active. 

 16. In cell D10, enter 8.99, and 
then press ENTER 

Cell C9 becomes active again. 

 



QUICKLY ADJUSTING A COLUMN WIDTH 

On occasion, you will discover that the text or values you have entered into a 
cell are not completely visible. This will occur when the number of characters 
entered exceeds the width of the column and when data appears in the cell to 
its right, as shown in column B of Figure 1-10.  

 

In the example, the entries in cells A1 and A2 appear just fine, because there 
are no entries to the right in cells B1 and B2. If the text or value appears cut 
off or overflows into a totally different column which will have its own data, 
you can quickly adjust the column width so you can view the entire cell entry.  

 

 
 

 

lumn heading Co

 

 

 

Figure 1‐12: Text Too Wide for the Column 

METHOD  

To quickly adjust a column width: 

 

1.  Double‐click the right border of the column heading. 

EXERCISE

 

In the following exercise, you will adjust a column width. 
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 1. Double-click the right border of 
the column heading for 

The column adjusts to 
accommodate the long text. 

 

FINISHING A WORKBOOK 

At the end of the day, or when you have completed your work on a particular 
workbook, you need to ensure that your work is safely stored. You can save 
your workbook in a number of ways, even as an Internet-compatible HTML 
document. In addition, you may want to make a printout of your worksheet to 
view the latest additions on paper or to share your worksheet with others. 

 

SAVING A NEW WORKBOOK 

When you save a workbook file, you tell Excel to accept every change you’ve 
made since the last time the workbook was saved.  It’s a good idea to save 
frequently, especially when you enter a lot of data or make major changes. 
That way, if there’s a power outage or surge, you will lose only a few minutes 
of work. 

 

If you invoke the Save command in an unnamed workbook, Excel prompts 
you to name the workbook before it will save it to disk. From then on, Excel 
saves your workbook under that name unless you specify otherwise. 

 

 

 

 

Figure 1‐13: The Save button is lit up as you Mouse‐over it 
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METHOD  

To save a new workbook: 

 

1.  Click the OFFICE button, choose Save. 

or 

1.  Click the Save button. On the Quick Access Toolbar (looks like a 
floppy disk). 

2.  In the Save As dialog box, in the Save in drop‐down list box, 
select the desired drive. 

3.  In the list of folders, double‐click the desired folder. 

4.  In the File name drop‐down list box, type the document name. 

5.  Choose Save. 

EXERCISE

 

In the following exercise, you will save your new workbook. 

 

 1. Click the OFFICE button and 
choose Save 

The Save As dialog box 
appears. 

 2. In the Save in drop-down list 
box, select drive C: 

The contents of drive C: 
appear. 

 3. In the list of folders, double-
click the Data folder 

The contents of the Data folder 
appear. 

 4. In the File name drop-down list 
box, type Brian’s Orchard 
2007 Report 
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 5. Choose Save The worksheet is saved as 
Brian’s Orchard 2007 Report 
and the new name appears in 
the title bar. 

 



SAVING A NAMED WORKBOOK 

Once you have named your workbook, you can save subsequent changes by 
simply using the Save command. Excel automatically saves it under its 
current file name. 

 

To give you more flexibility, you can also save a named workbook under a 
different name using the Save As command. One benefit of doing this is that 
it gives you two copies of the same workbook; you can modify the copy all 
you want without affecting the “original,” allowing you greater freedom for 
experimentation with formatting and other features. 

METHOD  

To save a named workbook with its current name: 

 

1.  Click the OFFICE button and choose Save. 

or 

1.  On the Quick Access Toolbar, click the Save button. 

 

To save an already named workbook with a different name: 

 

1.  Click the OFFICE button and choose Save As. 

2.  In the Save in drop‐down list box, select the drive on which to 
save the workbook. 

3.  In the list of folders, double‐click the folder in which to save the 
workbook. 

4.  In the File name drop‐down list box, type the new name. 

5.  Choose Save. 
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EXERCISE

 

 

In the following exercise, you’ll make changes to your workbook and save 
the file under another name. 

 

 1. In cell D1, enter Draft Only  

 2. Click the OFFICE button and 
choose Save As 

The Save As dialog box 
appears. 

 3. In the Save in drop-down list 
box, select drive C: 

The contents of drive C appear. 

 4. In the list of folders, 
double-click the Data folder 

The contents of the Data folder 
appear. 

 5. In the File name drop-down list 
box, type Orchard Report 
Draft 

 

 6. Choose Save The file is saved and the dialog 
box closes. The title bar 
displays the new file name. 
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PRINTING A WORKSHEET 

You may want to print your worksheet when you’ve finished working with it. 
This will give you a hard copy of your data to look over and to share with 
others. Best of all, you can get a quick printout of the active worksheet very 
easily. 

METHOD  

To print a worksheet: 

1.  Click the OFFICE button and choose the Print button. 

 

EXERCISE

 

In the following exercise, you will print a worksheet. 

 

1. Click the OFFICE button and 
choose the Print button. 

The PRINT dialog box 
appears. 

2. Select options. Click the PRINT button. 

  The worksheet is printed. 
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CLOSING A WORKBOOK AND EXITING FROM EXCEL 

Closing a workbook removes it from your screen but leaves you in Excel so 
that you can keep working. Before you close a workbook, you should make 
sure that you’ve saved your work. If you’ve forgotten, however, Excel reminds 
you that you need to save the document and gives you a chance to do so. 
You can exit from Excel after you have saved and closed any open 
workbooks. 

METHOD  

To close a workbook: 

 

1.  Click the workbook Window Close button. 
or 

1.  Click the OFFICE button and choose Close. 

2.  Save the file if prompted. 

 

To exit from Excel: 

 

1.  Click the application Close button. 

or 

1.  Click the OFFICE button and click the Exit Excel button (bottom 
right). 

2.  Save the file if prompted. 
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EXERCISE

 

In the following exercise, you will close the Orchard Report Draft workbook 
and exit Excel. 

 

 1. Click the workbook Window 
Close button 

 

 2. If a message appears asking 
you if you would like to save 
the changes to the workbook 
file, choose Yes 

The workbook closes. 

 3. Click the application Close 
button 

Excel closes. 
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ASSIGNMENT 

  1.  Load Excel. 

  2.  Select cell C3 with the keyboard. 

  3.  In cell C3, enter Cathy’s Computers 

  4.  In cell C4, enter Sales Report 

  5.  Using the keyboard, select the range B6:E6. 

  6.  Using Figure 1‐13 as a guide, enter the years in the range B6:E6. 

  7.  Select the entire worksheet. 

  8.  Use the mouse to select the range A7:A10. 

  9.  Using Figure 1‐13 as a guide, enter the product names into the range A7:A10. 

 10.  Enter zeros in the range B7 through B10. 

 11.  Using a range, enter the data for 2005, 2006, and 2007. 

 12.  Adjust the width of column A so you can read the text clearly. 

 13.  Select the nonadjacent cell ranges B6:E6 and A7:A10. 

 14.  Save the worksheet in the Data folder on the C: drive as Cathy’s Computers 

  15.  Save cells A1:E10 in the Data folder as an HTML document (with no title or 
header) with the name Cathy.htm 

  16.  In cell A11, enter Yearly Total 

  17.  Use Save As to save the workbook again. Use the file name Cathy’s Computers 
Draft 

 19.  Print the worksheet. 

 20.  Close the workbook, and then exit Excel. 
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